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Preface 

 

Todayôs society is shaped by sudden growth and development of the 

information technology (IT) resulting with its great dependency on the 

knowledge and competence of individuals from the IT area. Although this 

dependency is growing day by day, the human right to education and 

infor mation is not extended to the IT area. Problems that are affecting 

society as a whole are emerging, creating gaps and distancing people from 

the main reason and motivation for advancement ï from opportunity . Being 

a computer illiterate person today means being a person who is unable to 

participate in modern society, and a person without opportunity; and despite 

the acknowledged necessity and benefits of inclusive computer literacy from 

institutions like the European Commission, UNESCO, OECD, there are still 

groups of people having difficulties accessing basic computer education viz. 

persons with disabilities, persons with learning difficulties, migrant workers, 

unemployed persons, persons that live in remote (rural) areas where IT 

education is not accessible.  

These notes, combined with other materials published on ITdesk.info, 

represent our effort and contribution to promotion of the human right to 

education and information considering IT area.  We hope that this education 

will help you master basic computer skills and with that hope we wish you to 

learn as much as you can thus becoming an active member of modern IT 

society. 

 

Sincerely yours, 

 

ITdesk.info team 
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The first steps: 

¶ Turning the computer on: 

o connect all the components then plug in the power cord into the wall socket 

o press the key to turn on the computer 

o login using your username and password if it is password protected 

 

¶ Turning off the computer: 

o press ,  then  ; options:  

Á Stand by 

Á Turn Off  

Á Restart  (the key Reset on the computer case has the same 

function) ï turns the computer off and then on again  

 

 

¶ In the event that an application does not respond 

to a command, open the Task Manager 

(press the keys Ctrl + Alt + Delete 

simultaneously) 

 

 

o ending a non-responding (ñfrozenò) 

application: on the Applications tab 

choose the non-responding application 

and then press ĂEnd Taskñ 

 

 

 

¶ To open the Help function: click with the left mouse button on the Start menu and then choose Help. The 

following window will open: 

 

 

 

 

 

¶ In the blank 

field next to the word ñSearchò 

enter the name of the tool or 

term you need help with and 

press the left mouse button on 

the arrow ñnextò or press 

ñEnterò 
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WINDOWS XP operating system 

 

The Desktop  

¶ is always in the background, the "office desk" 

¶ users can adjust the outlook of the desktop in many ways 

¶ it contains: 

o the Start button  

o icons 

o the taskbar 

 

 

Start: 

¶ to begin working on the computer, click with the left mouse button on the Start button. A menu with 

submenus will  open 

 

 

 

 

 

in the left column of the Start menu you can find: 

o shortcuts to installed Internet browsers (programs that search 

the Internet and enable viewing of web pages), examples of these 

shortcuts on the picture are Mozilla Firefox and Internet Explorer; 

software for sending and receiving electronic mail (e-mail), an example 

of this kind of software on the picture is Mozilla Thunderbird  

o shortcuts to the most frequently used applications, examples on 

the picture are: FileZilla, Media Player Classic, Notepad, etc. 

o All Programs ï the menu that lists all installed programs 

enabling you to run the desired software 

in the right column of the Start menu you can find: 

o My Documents ï the default folder for user files  

o My Recent Documents ï the list of recently used files  

o My Pictures ï the default folder for user pictures  

o My Computer ï browses the 

computer for folders and 

files 

 

 

o Printers and Faxes ï enables 

viewing of installed printers 

and faxes 

o Control Panel ï this panel 

provides all options for 

managing the computer 

http://creativecommons.org/licenses/by-nc-nd/3.0/hr/
http://creativecommons.org/licenses/by-nc-nd/3.0/hr/
http://creativecommons.org/licenses/by-nc-nd/3.0/hr/
http://www.mozilla.com/en-US/
http://www.microsoft.com/nz/windows/internet-explorer/default.aspx
http://www.mozillamessaging.com/en-US/thunderbird/


ITdesk.info ï project of computer e-education with open access 

ITdesk.info is licensed under a Creative Commons Attribution- 

Noncommercial-No Derivative Works 3.0 Croatia License. 3/21 

(display, sound, add or remove program etc.) 

o Help and Support  

o Search ï searches the computer for a file or folder  

o Run ï runs applications by entering the name of the application (.exe) 

o Log off ï logs off the user, but does not shut down the computer 

o Turn Off Computer ï options: shut down or restart the computer 

 

Icons: 

¶ images that represent applications, program shortcuts, folders, or files 

¶ predefined Microsoft Widows icons are: My Computer, My Documents and the Recycle Bin 

¶ most frequent icons: folders, applications for text editing (OpenOffice.org Writer, Microsoft Word) 

 
 

Working with icons 

¶ Selecting icons: position the mouse pointer (cursor, arrow) over the desired icon, press and release the left 

mouse button; the icon will become colored meaning that it is selected 

¶ Moving icons (the drag-and-drop method): 

1. press and hold down the left mouse button on the desired icon 

2. drag the icon to the desired position 

3. release the left mouse button 

¶ Opening an icon: 

o double-click on the icon with the left mouse button, or 

o select the icon and press Enter 

 

 

Shortcuts to programs or files 

  This is an icon for a file in the PDF format named syllabus 

¶ double-click on the shortcut with the left mouse button in order to open a file or start a program    

¶ shortcut icons have an arrow within the white square in the lower left corner 

¶ its size is 1 kb; you can delete shortcuts without consequences to the program or document that the 

shortcut points to 

¶ creating a shortcut: 

1. press and hold down the right mouse button on the icon of the application, folder, or file 

2. drag the icon to the desktop using the mouse and release the right mouse button 

3. choose the option Create Shortcut Here 
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Taskbar: 

 

¶ it is located on the bottom of the desktop 

¶ shows running programs, open folders and files;  

¶ can be moved, hidden 

¶ has an area called Quick launch to place shortcuts of  favourite applications   

Windows 

¶ folders and files open within a window, some programs open in full screen (games for example) 

¶ window elements: 

1. Title bar 
2. Menu bar 

3. Toolbar 

4. Status bar 

5. Side bar ï horizontal and vertical 
6. Buttons: minimize, maximize (restore) and close 
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¶ Moving a window: 

o press and hold down the left mouse button on the windows title bar, move it in a desired direction, 

release the mouse button (the drag and drop method) 

 

¶ Resizing a window: 

o Position the mouse pointer over the edge of the window, press and hold the left mouse button, change 

the window size as you please, release the mouse button 

 

o buttons in the upper right corner of the window: 

 Minimize: minimizes the window placing it on the taskbar 

 Maximize: resizes the window to cover the entire desktop 

  Restore: restores the window to the size it was before maximizing it 

 Close: closes down the program or folder  

 

¶ Working with multiple windows 

o you can have more than one window open, but only one active 

o the active window has a highlighted title bar which is greyed out when inactive 

 
o you can activate a window by pressing on it with the left mouse button 

o when on the taskbar, you can activate the window by pressing the left mouse button on its slot  

 

 

 

Data organization on the computer 

 
Data storage devices: 

¶ Hard Disk 

¶ Floppy Disk 

¶ CD, DVD 

¶ USB Stick 

¶ online data storage device 

http://creativecommons.org/licenses/by-nc-nd/3.0/hr/
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Working with data storage devices within Windows XP 

¶ Start > My Computer ï the window displaying data storage devices:  

 

¶ Each device has an appropriate icon, title and letter within the brackets (A, B, C, D, E...): 

A - Floppy disk 

C ï usually a system disk- the disk the operating system is installed on 

D, E - usually assigned to CD, DVD, DVD-ROM or CD-RW  

o there can be more than one disk drive in the computer and one disk drive can be divided into several 

partitions 

o if there is more than one disk drive in the computer, or more than one partition on the hard disk 

drive, the letters usually assigned are: 

A - Floppy disk 

C - usually system disk ï the disk the operating system is installed on 

D ï usually the letter for another partition or the hard disk drive 

E, F- usually assigned to CD, DVD, DVD-ROM or CD-RW 

 

Files and folders 

¶ data on the computer is placed within files  

o a file: a set of digital data representing specific content (text, image, video, program) 

Á defined by a name and an extension 

Á the extension indicates a file format (files containing images -. jpg, text documents - .doc 

or .odt, sound -. mp3) 

o files are placed in folders 

Á a folder (directory): a container files or other folders are placed in. You can create files 

and folders within a folder in order to better organize data 

http://creativecommons.org/licenses/by-nc-nd/3.0/hr/
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Á a folder can contain subfolders which can have their own subfolders and they can also 

contain subfolders ... ï a branching map 

Á path - the path to a desired folder or file 

¶ if you choose the Folders tool in the folder window: 

o you get the 

Windows 

Explorer view 

o the hierarchical 

structure of 

folders appears 

on the left side 

 

 

 

 

 

 

 

 

 

 

 

 

Working with files and folders within Windows Explorer 

¶ displays the hierarchy of folders 

¶ Start > All programs > Accessories > Windows Explorer; or press the right mouse button over the Start 

button and on the quick menu choose Explore 

¶ working within the left pane of the window: 

o displays entire folder structures enabling easier navigation 

o +  folders can be further branched 

o ï  folders are branched out 

o press the left mouse button on a folder and in the right pane of the window folder its content will 

be displayed 

¶ working within the right pane of the window: 

o folders will open if you double-click on them 

o when Detailed view is selected, several informational columns will be shown: 

Á Name ï lists files and folders by name 

Á Size ï shows the size of files and folders on the disk 

Á Type ï shows file type (text file, spreadsheet, picture, video etc.) 

Á Date Modified ï shows the date when the file was last modified 

Á Status bar ï located on the bottom of the window; provides information about the file or 

folder 

http://creativecommons.org/licenses/by-nc-nd/3.0/hr/
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Creating folders and subfolders 

¶ Windows Explorer: within the left pane of the window select the folder you want to create a subfolder in 

and: 

o on the menu bar select File, then New > Folder > enter a name > press Enter; or 

o press the right mouse button within the right pane of the window > New > Folder > enter a name 

> press Enter 

Displaying the name, size and location of a folder and subfolder 

¶ the view can be changed by choosing the tool View; the options are: 

o Thumbnails 

o Tiles (on the image below) 

o Icons 

o List 

o Details 

 

 
 

 

¶ each file has its own properties: 

o press the right mouse button on the file and on the quick menu 

select the Properties option  

o it displays the location, size, creation date, date modified, author 

etc. 
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Files and folders can be hidden: 

¶ press the right mouse button on the file and choose Properties; on the tab General mark the checkbox next 

to Hidden, press the Apply button and then OK 

¶ the dialog box Confirm Attribute Changes appears with the following options:  

o Apply changes to this folder only 

o Apply changes to this folder, subfolders and files 

 
 

¶ Hidden files and folders can be made visible: 

o on the Tools menu choose Folder Options; on the tab View select Show hidden files and folders; 

press the Apply button and then OK 

 

To show the file extension  

¶ files have extensions that define the file type and determine the application that will open the file. The 

extension is placed after the name, separated by point 

¶ to display the file 

extension: on the 

Tools menu 

choose Folder 

Options; open the 

tab View and 

unmark the 

checkbox next to 

ñHide extensions 

for known file 

typesò. Confirm 

the change by 

pressing the Apply 

button and then 

OK 
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To change a file status 

¶ files can be opened, modified and deleted if their properties allow it  

¶ change the file status to read only: select the tab General, press the left mouse button over the box next to 

the Read Only attribute, confirm the change by pressing the Apply button and then OK 

¶ when you want to change the file status back, press the left mouse button over the same box and the box  

becomes empty again, confirm the change by pressing the Apply button and then OK  

 

Most often used files: 

OpenOffice.org suite Extension: 

text document: Writer .odt 

create and view presentations: Impress  .odp 

work with spreadsheets: Calc .ods 

 

Microsoft Office 
Extension: 

2003 version 2010 version 

text document: Word  .doc .docx 

create and view presentations: PowerPoint  .ppt .pptx 

work with spreadsheets: Excel  .xls .xlsx 

 

More applications: Common 

extension: 

audio file .mp3 

image .jpg 

video file .mpeg 

compressed file .zip 

executive file .exe 

  

Renaming files and folders 

¶ press the right mouse button over the file, on the quick menu choose the option Rename, enter the name 

and press Enter  

¶ be careful not to change the extension, or you might not be able to open the file  

 

Selecting files and folders 

¶ selecting one file: press the left mouse button on the file 

¶ selecting a number of sequential files ï press the left mouse button on the first file, press and hold the 

Shift key and press the left mouse button on the last file, then release the Shift key 

¶ selecting a number of files that are not sequential ï press the left mouse button over the first file, press and 

hold Ctrl and then press the left mouse button over other files or folders you want to select, then release 

the Ctrl key 

¶ selecting all files within a specific folder: on the Edit menu choose the option Select All (keyboard 

shortcut Ctrl + A) 

http://creativecommons.org/licenses/by-nc-nd/3.0/hr/
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File count 

¶ to count files within a folder: press the right mouse button on the folder > Properties> and see the files and 

subfolders the folder contains 

¶ count the same file type: View > Details > Display Type> Check files of the same type> you can find the 

number in the status bar 

 

Copying files and folders: 

1. select the file or folder you want to copy 

2. press the right mouse button and on the quick menu choose the tool Copy  (Ctrl + C) 

3. position the cursor to the place you want to copy the content to  

4. press the right mouse button and on the quick menu choose the tool Paste  (Ctrl + V) 

Copying via drag and drop method: 

1. select the file or folder you want to copy 

2. over the selected file or folder press and hold down the left mouse button and then press and hold 
down the Ctrl key 

3. ñdragò the mouse pointer to the place you want to copy the content to  

4. release the mouse button and then release the Ctrl key 

 

Moving files or folders: 

1. select the file or folder you want to move 

2. press the right mouse button and on the quick menu choose the tool Cut  (Ctrl +X) 

3. position the cursor to the place you want to move the content to 

4. press the right mouse button and on the quick menu choose the tool Paste  (Ctrl + V) 

Moving via drag and drop method: the same as copying, but without the Ctrl key- just apply the drag and drop 

method. 

 

 

Deleting files and folders 

¶ Windows Explorer > within the left part of the window select a folder containing files or folders you want 

to delete > in the right window select the file or folder and on the File menu choose Delete 

¶ right-click on the folder or file and on the menu select Delete 

¶ press and hold the left mouse button over the file or folder you want to delete, drag the cursor to the 

Recycle Bin and release the mouse button (drag-and-drop)  
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Restoring files and folders 

¶ deleted files and folders 

are moved to the 

Recycle Bin 

¶ options: 

o Empty the 

Recycle Bin 

o Restore all 

items 

¶ restoring a file: press 

the right mouse button 

on it and on the menu 

choose Restore  

 

Compressing files and folders 

¶ compression reduces the space the data occupies on the disk 

o right-click the file or folder and select the command Send to  > Compressed (zipped) Folder  

o a compressed folder or file is created with the same name as the original and with the letter Z on the 

icon  

o to add files and folders use the drag-and-drop method 

o programs for compression are: Win Zip, WinRar 

 

 

Decompressing files and folders (extract) 

¶ in order to modify compressed files and folders you need to decompress them first 

 
o right-click over the compressed folder or file > select a decompressing program > specify the 

location you want to save the folder in  
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